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Chapter1: Introduction 

1.1 What is VirtualDrive Network 

VirtualDrive Network (VDN) from FarStone Technology Inc., includes the VDN 

Server, VDN Console and VDN Client programs. VCDs created using the VDN Console 

program can be stored on your network and run on Client PCs or Workstations using 

the VDN Client program. 

The following picture displays VirtualDrive Network’s framework: 

 

 

 

1. Server saves all VCD file list, user list and management settings.  

2. Console adds CDs/VCDs stored in the shared folder(s) into Server’s file lists, and 

manages these VCD files. 

3. Client plays VCD files in the Server (please make sure Server is running) 



 

 
Tip 

Server end and Console end can be installed in the same computer. 

 

You can create up to 23 Virtual CD/DVD Drives that are accessible through 

Windows Explorer just like a regular physical CD/DVD Drive.  You no longer need to 

change CDs by hand, deal with the hassle of trying to find them, and keeping them 
clean and working. 

 

1.2 Features and benefit 

1. Runs applications without CD-ROM:  

Select and insert a VCD into the VirtualDrive and the VCD appears as though a CD is 

actually in a physical CD drive. 

 

2. Supports most disc formats, including: 

CD-ROM, Audio CD, DVD-ROM, DVD-Video, Video CD, Mixed-Mode CD, Multi-Session 

CD, CD-Extra, CD-Text, BD and Photo CD. 

 

3. Automatically recognize CD format 

VirtualDrive can distinguish the type and format of the CD it is compressing, and run 

the correct program. 

 

4. Faster than a 200X CD-ROM drive: 

Run CDs directly from the hard drive with incredible 200X speed. (with Ultra DMA 

drives) 

 

5. 1000 Virtual Jukeboxes:  

VirtualDrive Network supports up to 1000 Virtual CD Jukeboxes (CD folders), with 

each folder able to hold an unlimited number of CDs. 

 

6. Burn your VCDs onto a recordable disc  



VirtualDrive combines the functions of CD/DVD/BD emulation software with 

CD/DVD/BD burning capabilities. It allows users to copy CD/DVD/BD images from 

the hard disk to a recordable medium.  

 

7. Easy Management:  

The Console creates and configures the VirtualDrive Network. Changes affect clients 

instantly. Clients have no need to worry about the details. VirtualDrive doesnt copy 

hundreds of thousands of files from the CD. Rather, it actually creates a CD image 
file on the hard drive. Only this image file needs to be created or removed. 

 

8. Compression:  

VirtualDrive incorporates a high performance compression engine and automatically 

decompresses on the fly when the VCD is accessed. 

 

9. Removable media:  

 VCD files can be placed on many different types of removable media extending the 

capability of such systems. 

 

10. Saves space and hardware costs: 

 Take no physical space in your office and has no hardware maintenance costs.  

 

11. 100% compatible:  

 VirtualDrive is completely compatible with all types of CD applications. Some CD 

applications only run (lock) from a physical CD drive. These applications will not run 

from a mapped network drive, like a drive mapped to your server CD drive (or 
Jukebox). VDN supports all such CD applications. 

 

12. Share Resources:  

 Storing Virtual CD's on a file server allows CD resources to be shared throughout 

the network. 

 

13. Built in CD benchmark and browser: 

 Evaluate the data transfer rate and access time for any of your CD drive(s). 

 



14. CD Audio Compression:  

 Listening to your favorite music has never been easier. Just select the tracks you 

like and they will be automatically compressed and converted to an VCD file.  

 

15. VirtualDrive Custom AUTORUN feature:  

 VirtualDrive Network provides a (built-in) comprehensive way to automatically 

startup VCDs. 

 

16. Create Custom Virtual CDs from selected files: 

 Customize your own VCDs by removing unnecessary files from the source CD. 

 

17. Easy CD Management:  

 Organize CDs and manage all CD access from a single workstation. 

 

 18. Security 

 The VirtualDrive Network can set security properties according to clients' demand. 

Each client can only use the Virtual CD authorized by Console. 

 

19. ISO Support  

 VirtualDrive Network supports the ISO image file format, so you can transfer you 

data more conveniently. 

1.3 Benefits for Schools and Businesses 

1.3.1 Benefits for Schools  

1. Easy management:As many as 500 CD-ROMs may be needed for a class with 25 

computers and 20 educational CD titles. With VDN you no longer have to manage all 

the discs and worry about damaged discs or losing them.  You only need one copy of 
each title to create a VCD image.  

2. Client machines don't need CD/DVD drive: Students are unable to install their 

own personal CD software.  You save money by buying computers without CD/DVD 
Drives. 



3. The VDN Server: Everyone has 24/7 access to the VCDs on the server from any 

computer on the network. 

1.3.2 Benefits for Businesses  

1. RD departments: Information is at your fingertips. Keep everything on the VDN 

CD server such as MSDN resource CDs, and reference guides. 

2. Education: Employee trainings can be more efficient and cost effective by storing 

training materials on the VDN Server. 

3. Information Management: The amount of data to be stored is always 

increasing. VDN CD server can be used to efficiently manage data resources or 
totally replace CD Jukeboxes systems. 

Chapter 2: Installing VDN 

The Brief guide to VDN installation 

VirtualDrive Network(VDN) consists of Server, Console and Client. You need to install 

Server first, and then continue to install Console and Client through the network 
folder shared by Server.  

 

1. Install the VDN Server 

 Please log on Windows through administrator user account, run the installation 

Program. 

 Please Pay attention in installation process: 

  (1)  You need to enter company name; 

  (2)  You should select folder to store Console & Client installation application. And 

the program will share it.  

 In the last step for installing VDN Server, it will show you the shared folder (e.g. 

\\Local IP\VDN) which VDN Console and VDN Client located in. You need to access 

this shared folder through the computer you want to install Console and Client to 
complete installation process of Console and Client.  



  

  

  
Note 

If the computer which installed VDN Server did not execute “Network 

Sharing Wizard” before, you may cannot access the shared folder it 

shared. Please run “Network Sharing Wizard” manually to share the folder 
which contains Console and Client installation application. 

   
   

2. Install the VDN Console (Console and Server can be installed together) 

Please Use administrator user account to log on the computer which you want to 

install Console. Then, access to the shared folder (\\VDNServer\VDN), run Setup.exe 
in it to begin installation process. 

 

   
Note 

In the interface to choose storage path, you need to 

check “VirtualDrive Network Console” to install Console. 

After finishing installation, you can run console to Create 

Virtual Disc , burn disc, manage cabinet and so on. 

 

In order to keep the stability and efficiency of VDN, we suggest you just install one 

Console. 

 

3. Install the VDN Client 

Please use administrator user account to log in the computer which you want to 

install Client. Then, access to the shared folder (\\VDNServer\VDN), run Setup.exe in 
it to begin installation process. 

 

   
Note 

If you have installed Console, please do not check 

“VirtualDrive Network Console” in the interface to 
choose storage path.  

 

After installation complete, you can run Client to insert Virtual disc and other 
operations. 



2.1 System requirements 

1. VDN Server  

    Windows XP/Server 2003/Vista/Server2008 (32-bit & x64) /Windows 7/Windows 

8 /Windows Server 2012 
  

2. VDN Console: 

    Windows XP/ Server 2003/Vista/Server2008 (32-bit & x64)    /Windows 7 

    A CD/DVD drive  
    40 MB HDD space if working peer to peer 

3. VDN Clients: 

    Windows XP/Server 2003/Vista/Server 2008 (32-bit & x64) / Windows 7  

    No CD/DVD drive is required. 
  40 MB HDD space if working peer to peer 

2.2 Installing the VDN (VirtualDrive Network) Server 

Pre-Installation    

Be sure to install the VDN components according to the following order: Please install 

VDN Server first, then VDN Console/VDN Client. Make sure that VDN Server works 

normally during the installation of VDN Console and VDN Client. 

  

Follows the steps below to install VDN Server:  

Step 1 Insert the VDN CD into the CD drive and run the VDN installation program 

(Setup.exe) or run self-extracting installation package(EXE) downloaded from the 

Internet.  

Step 2 Select your language preference and click OK. 

Step 3 Click Next to continue. 

Step 4 Carefully read the License Agreement and select Yes, if you accept the 

license conditions. 

Step 5 Enter your personal information and then click Next to proceed. 

Step 6 Select the installation location (e.g. C:). And then click Next to begin the 

installation.  

 



Step 7 Carefully read the note, if you haven't shared a file or folder before, our 

program's share folder may can't be accessed. Please run the "Network Setup Wizard 

" or "Just enable file sharing". Click OK to continue. 

Step 8 A dialog box pops up to tell you the success of installing VDN Server. It also 

shows you the shared folder (e.g. \\Local IP\VDN) which VDN Console and VDN 

Client located in. Click Finish to complete installation of the VirtualDrive® Network 
program files. 

You will need these two shared directories to install the VDN Administrtor/ VDN 

Client, and make those two work properly. So it is suggested that you check the 
share setting prior to installing the other two components.  

2.3 Installing the VDN Console or Client programs 

Once the VDN Server have been installed into a shared directory, both the VDN 

Console and the VDN Client installations can be executed by running the setup.exe 

file from the VDN Server shared directory.  There are two methods to install the VDN 

Console and Client programs ---manual installation and silent installation.  
 

Follow the steps below to run manual installation: 

Step 1 Select Start on the Windows taskbar, then Run. 

 Step 2 Enter the UNC path to the setup program, the shared VDN Server directory.  

 

  

  

Note 

The shared VDN Sever directory is composed of the 

computer name and shared folder name where 

VirtualDrive® Network sever program is installed. (e.g. 

\\local IP\vdn\setup). The "local IP" is the IP address 

where the shared folder in, and "vdn" is the shared folder 

name. 

  

Step 3  Click Run to launch the VDN Setup Wizard.  

Step 4  Select your language preference and click OK 

Step 5   Click Next to continue. 

Step 6   Carefully read the License Agreement and select I accept the terms in 

the license agreement, if you accept the license conditions. Click Next to 
continue. 

 



Step 7  Select the installation location(e.g. C:). Select the checkbox below if you 

want to install the VDN Console. If you do not want to install VDN Console, do not 

select it. And then click Next to begin the installation.  

a.     If you do not select to install VDN Console, you will install VDN Client only. VDN 

Client will require you to enter the product serial number: You also can use an 

evaluation version without a product serial number for 15 days. And you just 

need to enter serial number in VDN Client, VDN Console do not need to enter 

serial number. will Click Install to begin the process. Then click Finish to finish 
installation. 

b.     If you select to install VDN Console, click Install to begin installation. Then click 

Finish to finish installation. 

Chapter3: Using the VDN Console Program 

3.1 Starting the VDN Console  

The "VirtualDrive" icon will be displayed in the bottom-right corner in the Windows 

Taskbar after the VDN console program is successfully installed on the console 
workstation. 

 

 
 

To start the VDN console program, double click on the VirtualDrive tray icon or right 

click on the tray icon and select "VirtualDrive Network Console". 

 
 

 
 



Click Continue and a dialog box will pop up: 

 
 

 
 

 

  

    

Note 
The default password is nothing.  

 

Click OK and you will enter the VDN Console: 

 

 



 
 
 

 

3.1.1 The VDN Console  

Toolbar: 

 

 

 

 

 

The above figure is the default toolbar of VDN Console.  



 3.1.2 VDN Right-Click Menu in Taskbar 

After successfully installing the VDN Console program on the Console workstation, 

the "VirtualDrive" icon will be displayed at the bottom-right corner in the Windows 
Taskbar. 

 

 

 

Right-click on this icon will open the figure: 

 

 

  

VirtualDrive Network Console: Launch VDN Console  

VirtualDrive Client: Launch VDN Client 

New Custom Image :Start CD/DVD Burning  

New VIrtual Drives: Set the number of virtual drives 

Divice Properties: Check the Device Information and Disc Contents  

Browse: Check the number of virtual drives and inserted CD information  

Exit: Quit VirtualDrive Network 



3.1.3 VDN Console Settings 

Changing the Password 

Click View up the toolbar, then select Option. A dialogbox pops up. Click the 

checkbox to select Verify the authority for VCD folder---- Enables the Password 

dialog on client side computers. 

 

 

 

 

You can set or change the password to the VDN Console by selecting Security on the 

menu bar. Then select Password. 

You will be required to enter the current Console Password, type in the new 

password and then re-enter the new password to confirm.  

VDN Console Setup -Views 

Select Views on the menu bar . 

large Icons: You will see the large icons on the interface if you select it. 

Small Icons: You will see the small icons on the interface if you select it. 

Cover View : You may customize CD covers by adding or editing the pictures. The 

utility enables you to easily find the virtual CD you want to access.(refer to 3.2.4) 

Detail: Select this to see the detail of file folders below. 

mk:@MSITStore:E:/my%20job/important%20documents/VDN/VDN14-En2011.01.20/test.chm::/_22.htm


3.2 Building Virtual CDs (VCDs) 

3.2.1 Create a Virtual CD from CD/DVD/Blu-ray Disc 

Click Create up the toolbar, you can create a Virtual CD from CD/DVD/Blu-ray Disc. 

  

 

  

Insert a CD into your drive to create a virtual CD. Follow the steps. If you do not 

need to create an image from CD/DVD/BD, please choose "Cancel".  

  

1. Insert the CD/DVD/BD into drive. 



  

2. Click "Refresh". Details of source CD/DVD/BD and the default setting for the file 

destination will appear in the box. 

  

3. Click Advanced setting to reselect source dirve, store path for disc image, set 

password protection for VCD and so on. Click Save to save your settings. 

  

    
Tip 

If you want the virtual CD you created added to the cabinet 

automatically, please keep the store path as 
defaulted(e.g.C:\users\user\Documents\VCD\ ).  

 

4. Click "Start". Create a virtual CD image. 

5. When the process finished, Click "Finish". Now, if you store the image in default 

path or network share, Virtual CD will be added into the cabinet automatically. 
Otherwise you can add it manually. 

3.2.1.1 Advanced setting 

  

 



 

  

 

Protection Type: select a known protection type from the dropdown list. Intelligent 

extraction is the recommended choice for you to protect your image. 

Author: Enter the name of the CDs publisher or author (i.e., FarStone Technology). 

Password: set a password for VCDs which will be required when accessing the VCD 

Data compression: save hard drive space; however, the "low" to "high" options will 

shorten or prolong the time it takes to build a VCD.     

Comments: the comments are the descriptions of the image. 

Once Advanced setting is complete, click "save". Start creating the virtual CD/DVD. 



3.2.2 Building an Image from files or folders 

You can burn a project of selected files to CD/DVD and BD or save it as a virtual CD 

(VirtualDrive Network Image file). Because disc types are created using the same 
method, we describe how to make them here. 

3.2.2.1 Creating a CD/DVD/BD project 

You can create various types of projects in the utility by clicking Create. To start a 

new Data CD/DVD/BD project, select any of the following options from the VDN 
Console: 

1. Click "create virtual CD/DVD from files/folders". You may directly enter into 

the interface of the project. 

2. New - Data CD/Data DVD/data BD or; 

3. Click the small triangle to the right of the New button, then select Data CD/Data 

DVD/data BD, or; 

4. Right-click in the Project Pane and select New - Data CD/Data DVD/data BD. 

  

 



 
 
 

3.2.2.2 Adding Files and Folders to a Project 

You can now add files and folders to your project using any of the following methods: 

1. Drag files and folders from the Source Pane or from Windows Explorer to the 

Current Project Pane.( Windows 2000/XP available only) 

2. Copy and paste files and folders from the Source Pane or Windows Explorer to the 

Current Project Pane. 

3. Select files and folders from the Source Pane, right-click on the selected objects, 

and click Add. 



4. Select files and folders from the Source Pane and choose Edit - Add to Project. 

5.Select Edit - Add File to display the Open dialog box. You may then select your 

files and folders. 

6. Right-click the Destination Project (to which the file will be added) or a destination 

folder from the Project Pane and choose Add File. This will display the Open dialog 
box, where you can select your files and folders. 

7. Right-click on any blank area of the Current Project Pane and select Add File to 

display the Open dialog box. Select your files and folders. 

3.2.2.3 Save the created files to be projects 

If you prefer to save the files as projects anywhere on your computer when the 

image is complete, you can do the following: 

1. Click Save button or Right-click in the Project Pane and select Save.  

2. A box pops up in which you can choose the location where the project is saved 

and set a name for it. 

 

  

3. Click Save 

  

  
Note 

As you add files to your project, you can preview documents, photos, videos, 

and audio files by double-clicking on their icons in the Source Pane. 



You can also view the contents of a folder by right-clicking on the folder and 

selecting Open. 

  

   
Note 

The horizontal scale bar at the bottom of the Project Pane displays the total 

size of the project. The default scale is set automatically according to the 

project type you are creating. 

You can change the scale by clicking the icon in the left corner of the toolbar. 

 

3.2.3 Creating a Virtual CD from a Project 

Whether do you have previously created a project or it is your first time to create, 

the feature can help you customize the project by following these steps: 

1. Choose a project which you previously created or create a project now (Details 

refer to 3.2.2.2) 

2. Select the project you want to customize. 

  

 

  

3. Click "open". Customize the files or folders. 



4. Right click in the project pane, you can add, delete and rename the files to 

customize the virtual CD. 

5. After customization is complete, choose the default location. There are two 

conditions for you to choose which are: 

 

 

  

      a. If you prefer to burn the project to an actual CD, you can choose the 

name of your drive.  

       b. If you prefer to burn it as an image to a location on your computer, 
choose "image recorder (VCD)".  

6. Click "burn" to begin building the image.  



3.2.4 Custom virtual CD 

After creating the image, you may customize CD covers by adding or editing the 

pictures, the way you want it. The utility enables you to easily find the virtual CD you 
want to access. 

1. Select virtual CD that you will customize in the cabinet. 

2. Click the small triangle to the right of the views button, then click Cover view. 

3. Right click the virtual CD that you plan to edit, select Edit CD/DVD artwork. 

4. Select the covers from your specified location. 

5. Click Open.  

 

 

 

 

  



 

 
Tip 

The edited covers can help to differentiate the virtual CDs from one another.  

 

3.2.5 Conversion between an ISO 9660 image file and a VCD file  

You may convert an ISO 9660 image file into a VCD file as well as convert a VCD file 

into an ISO 9660 image file. 

Step 1 Select File on the menu bar, then select Convert from the drop menu to 

open the Convert file window.  

Step 2 Click the Browse button to open the Windows file browser. 

  

 

  



Step 3 Select the ISO/VCD file you want to convert, then select Open to continue. 

Step 4 Select Convert to start the conversion. 

  

 
Note 

Audio VCD, DVD and compressed VCD file cant convert into ISO file. 

 

3.3 VirtualDrive CD/DVD/Blu-ray Burning Program  

VirtualDrive® combines the functions of CD/DVD/Blu-ray emulation software with 

CD/DVD/Blu-ray burning capabilities.  It allows users to copy CD/DVD/Blu-ray 

images from the hard disk to a recordable medium.  

 

3.3.1 Burn CD/DVD/Blu-Ray from a Virtual CD 

Create a CD/DVD/Blu-Ray which can protect all types of files and folders and is 

available in all supported windows systems.  

1. Insert a recordable Disc into a rewritable drive. 

2. Click Burn in the upside of the interface and select Burn CD/DVD/Blu-Ray 

from a virtual CD. 

3. Click the browse button  to select an Image file you want to burn and click 
Next.  

4. Entering the burning setup of the new Image in the description box, you can 

choose the following option to custom it 

Device information: you may find details about your drive 

Buffer underrun protection : When system resource is not enough, the 

feature can protect the CD that is recording and prevent burning failure. 

"Close CD" : the CD you record will stop adding data 

Verify data: make sure the data on the CD is correct 

Number of copies: you can choose the number of copies to make based on 

your demand 

5. Click Burn to begin building the Image on actual CD. 



3.3.2 Burn a Custom CD/DVD/Blu-ray Disc 

You can create a CD/DVD/Blu-ray  in which you can customize the type of files or 

folders based on your preference and which files and folders are available in all 
windows systems 

1. Click " Burn a custom CD/DVD/Blu-ray Disc ". 

2. Select Files and Folders you prefer to add to the Project (details refer to 3.2.2.2) 

3. Right click in the project pane. You may add, delete and rename the files to 

customize the virtual CD. 

4. After customization is complete, choose the default location. There are two 

options for you to choose: 

a. If you would like to directly burn the project to an actual CD, you can 
choose the name of your drive  

b.If you would like to burn the project as an image to a preferred location on 

the computer, choose "image recorder (VCD)".  

5. Click "burn" to begin building the image.  

3.3.3 Burn MP3 files onto a CD/DVD/Blu-ray Disc 

Burn all your collective MP3 files onto a CD/DVD/Blu-ray disc. The CD/DVD/Blu-ray 

can be played on any computer or player that supports MP3. It can store more music 
files than a typical CD. 

1. Choose MP3 files or folders and add them to the project. 

2. Click "PlayList",  

3. Enter the playlist editor box. In this box, you can change the name of the image 

and adjust the turn of songs by moving them up or down. 



 

 

4. You can save them as a project to the location you want or burn them directly 

onto the CD. 

5. Click "Burn" to begin building image. 

3.3.4 Burn an audio CD 

Create a standard music CD which can be played on any audio player. When creating, 

you can select any music from your hard drive. 

1. Select audio files or folders and add them to the project. The program will 

automatically determine which files are audio files. 

2. You can save them as the project to the location where you want or burn them 

directly into the CD. ( 3.3.5)  

3. Click "burn" to begin building image. 

  
Tip 



If you burn the WAVE files to audios, it is recommended to 

use files of WAV Digitization Quality, 44.1 K, 16-bit sound 
depth (bit rate=705 kbps). 

 

3.3.5 Burn a CD/DVD/Blu-ray Disc from a Project 

1. Click Burn -Burn a CD/DVD/Blu-ray Disc from a Project or Click the small 

triangle to the right of the Burn button, then select Burn a CD/DVD/Blu-ray Disc 
from a Project. 

2. A pop up box will appear. Choose which project to burn. 

3. Before burning, there are two default recorders for you to choose: 

If you would like to directly burn the project to an actual CD, set the 

default recorder to be hard drive. 

a. Insert a recordable CD into the drive. 

b. Click the Burn button in the optional menu. 

c. The burning setup box pops up and you can custom it by following 

options.  

Device information: you may find details about your drive 

Buffer underrun protection : When system resource is not 

enough, the feature can protect the CD that is recording and prevent 

burning failure. 

"Close CD": the CD you record will stop adding data. 

Verify data: make sure the data on CD is correct. 

Number of copies: you can choose the number of copies to make 

based on your demand. 

d. Click burn. 

 

If you would like to burn it as an image to a preferred location on the 

computer, choose "image recorder (VCD)" as the default recorder.  

a. Click "Burn" 

b. Enter a description of the new Image in the description box. Click the browse 

button to set an image name for your VCD file and save it to the default location C: 

c. A dialog box will display the attributes of the Image that will be created. 



d. Click Next.  

e. Enter the option box. 

Description:define the file type 

Author: Enter the name of the CDs publisher or author (i.e., FarStone Technology). 

Comments: The comments are the descriptions of the image. 

(Optional) You can set a password for Image files. The password will be required if 

you attempt to insert the Image or view the content of the Image. 

(Optional) If the CD does not have an Auto-run file, you can specify a program to 

run it when the Image is inserted. 

Using data compression will save hard drive space but will also require more time to 

build the Image. 

f. Click "Burn" to begin building image. 

 

3.3.6 Viewing Device Info 

The Device Info provides the detailed information of the installed CD/DVD device 

and the inserted CD/DVD.  

Select Tools from the VirtualDrive menu bar and then select Device Info from the 

dropdown menu to display the device information.   

 

 



   

 

 

There are three buttons on top right side of the Device Info page:  

  

 Refresh current device information.  

 Save your current device information as a text file on your 

hard disk.  

   

 

Send an e-mail about your device information to FarStone 

Technology.  This feature will be helpful for users to collect 

their system information and report it to FarStone technical 

support when errors occur when they are using 
VirtualDrive.     

 



3.4 Managing VCD access on the VDN Server 

3.4.1 Users and Groups - Overview 

A Group can be created to manage multiple users access to a VCD Cabinet.  

If you use Groups to manage access rights then you must create User Accounts for 

everyone using VDN and assign them to groups. 

3.4.1.1 Adding/Removing Users 

Add a new User by right-clicking in the Users and Groups frame then selecting New 

User from the drop menu to open the New User dialog(Figure below). 

 

 

 



 

 

Enter the User details and a Password if required. 

 

 

 

 

Click Create to add the User, or Cancel to close the dialog. 

Finally, click on Save to save the new configuration.    

 

    

Note 

No period, blank, or characters as [\ / [ ] : | < > + = )º, ? *] 

can be included in the user name. 

 

The new user is added into guests group at default setting. Please refer to 3.4.1.2 

Adding users to group if you want to assign users to another group. 

To remove a user select the User Name, right-click and select Delete from the 

popup menu.  

Adding/Removing Groups 

Right-click on the Groups icon and select New Group to open New Group dialog box. 

 

 



 

 

 

Give the New Group a Name and Description then click on the Create button(figure 

below). 



 

  

To remove a group, you can either (a) right click the group and select Delete from 

popup menu or (b) select the group and press Delete key on keyboard. 

3.4.1.2 Adding Users to Groups 

Select the User Name right-click and select User Properties from the popup menu. In 

the popup box, you can either assign single user by using the button or 

assign all users by clicking on  button to any of the listed Groups. On the 

contrary, use or button to remove users from groups. 

You can then use the arrow buttons to assign the User to any of the listed Groups. 



 

  

    

Note 

A user in a group has the same access as the group he is 
subject to.  

 

Changing a User Password 

Select the user's name, right-click and select Password from the popup menu. 

 

Type the password and confirm it.  Click OK to finish. 

 

 



 

 3.4.2 Sharing VCD Folder 

Users have access to the VCD files in VCD folders only if they have access privilege 

assigned by VirtualDrive Console. 

To share a VCD cabinet to users, select a VCD cabinet, select File -> Share or right 
click on it and select Sharing. 

  

 

  

You can share the cabinet with users and groups by adding or removing them from 
right pane of the Window. 

3.4.2.1 New Sharing 

Right click on share VCD Cabinet in left pane of VirtualDrive Console, select new 

sharing from the popup menu to open select folder window.  



 

Select a folder in this window and click Next to enter the next step. 

 

 

  

If you want to share this folder with users or groups, add them into the right pane of 

this window. 

3.4.3 VCD License 

By using VCD license, you can specify how many users may access VCD files at one 

time. 



3.4.3.1 Set License for a VCD File 

You can set the license for a VCD file by (a) Selecting a VCD file and pointing to 

License->Set License on the file menu or (b) Right clicking on a VCD and clicking 

Set License from the drop menu, either method will open the license window (figure 
below). 

 

 

 

The default setting is NO Limitation. You may change the license count by entering 

a number in the blank box. 

AS well, you may set VCD license number for a VCD folder and VCDs in it by 

repeating the process. 

3.4.3.2 View License 

You may inspect current license usage of a VCD file by (a) Selecting a VCD and 

pointing to License->View License on the file menu or (b) Right clicking on a VCD 

and clicking View License from the drop menu, either method shall open the 

window as below. 

  



 

  

VCD license information is displayed in this window, includes: VCD license number, 

the location of this VCD and who are using it. 

3.5 Managing VCDs in the VDN Server 

3.5.1 Adding VCD folders (CD Jukebox) 

Before VCDs can be added to the VDN Server, a Folder or CD Jukebox must first be 

created to hold the VCDs.   

Step 1 Click on Cabinet located on the left side of the VDN Console program 

window. Then right click on the blank space in right panel of the VDN Console 
window. A popup menu will be displayed. Select "New Cabinet".  

(The same function can also run from the Menu bar by selecting New then New 

Cabinet) 

Step 2 Type in the new Cabinet Name and Description then click Create to add the 

folder. When you have finished adding new folders, click Cancel to close the dialog. 



 

Step 3 Save the new VDN Folder Configuration 

Save the new configuration by clicking on the "Save" button or click "File" 

on the Menu bar and select "Save". VDN Clients will see the new configuration only 
after "Refreshing" their screen or restarting the Client program. 

3.5.2 Changing a VDN Folder Description 

Open the Folder Properties dialog by right-clicking on the folder and selecting 

Properties. Or, go to File -> VCD Folder -> Properties from the File menu. 

 

  

 

The Folder Properties dialog only allows the editing of the VCD folder description. 

3.5.3 Adding VCDs to a VCD Folder 

Step 1 To add VCDs to a VCD folder, first click on the VCD Folder name listed on the 

left side of the VDN Console program window. Then right click on the blank space in 

right panel of the VDN Console window. A popup menu will be displayed. Select 
"Add VCD". 



(The same function can also run from the Menu bar by selecting File then VCD files) 

Select the files that you want to add to the VCD folder and then click "Open". All of 

the selected VCD files will be added to the VCD folder. 

 

  

  

    

Note 

Files selected from the Network Neighborhood are UNC 
compliant.  

  

 

    

Important !   

VCDs cannot be added to the VDN server Console from: 

- a local drive  e.g. C:\vcds\mykids play.vcd or a mapped 

drive  e.g. F:\math1.vcd (while f: is mapped to 
\\server\vdn) 

VCD files must be stored within Shared folders and may be 

located on different file servers (as in a distributed network 
system).  

 

 

file://server/vdrive


    

Tips 

To add multiple VCD files at a time. Hold down the Ctrl key 

and click on each VCD to select, or hold the SHIFT down key 
to select block of VCD files in the file list.  

 

 

 

 

 

The added VCDs will appear in the Console window. 

Step 2 Save the new VDN Folder Configuration   

Save the new configuration by clicking on the "Save" button or Click "File" on the 

Menu bar and select "Save Configuration". VDN Clients will see the new 
configuration only after "Refreshing" their screen or restarting the Client program. 

    

Note 

The VDN configuration file is stored in the 

\\server\vdn\TvConfg.Bny. Before updating the configuration 

file://server/vdrive/TvConfg.Bny


file, the VDN Console program will make a backup copy to 

"$TvConfg.nnn". VDN maintains backups for the last 4 

configurations. 

 3.5.4 Deleting a VCD Icon or VCD File 

Right click on the VCD icon and select "Delete" to open the popup menu shown 

below.  

 

 

 

Click OK to Delete the VCD icon from the VDN Console. Only the VCD icon displayed 

in the VDN Console is removed from the VDN CD server, the VCD file remains on the 
network and may be added to the VDN Server again. 

To delete the VCD file and its icon check the Delete VCD files in the disk then click 

OK. This will remove the VCD icon from the VDN server and VCD file from the 
network. 

3.5.5 VCD properties & Custom Auto-run Function 

To view a VCD's properties, right click on that VCD's icon and select "Properties" 

from the drop menu to open the VCD Properties dialog box (shown below). A VCD's 
description can be edited from here. 

Additionally, VDN provides a comprehensive way to startup VCDs created from 

CD-ROMs with no built-in Autorun feature. 

To set up an Autorun function for a VCD, simply follow these steps: 

Step 1 Check the "Run the command listed below when VCD is inserted" 

Step 2 Fill out the command line to include the path and the name of the program 

file to be run. 



e.g."\setup.exe"or"\mydocFolder1\myFile.doc" or "\mydocFolder1\myPage.htm" 

 

 

 

3.5.6 Searching VCD 

Step1 Select Search  button or select File from menu bar, then 

Search VCD from the drop menu to open Search VCD Box.    



 

 

Select VCD folder in Path drop menu or browse for folders by clicking on button. 

Click on Search, the files are being searched will be displayed in the window. Select 

a certain file or multiple files (by holding down CTRL) you have found, and click Add 

to put them into a folder (figure below). 



 

 

Path: If "Search in VCD folder" radio box is selected, you can select 

a CD folder by cl icking on button or in search path box(figure 

3-4-6a); you may browse for folder from network drives by selecting 
"Search on Network"(figure 3-4-6b). 



 

figure 3-4-6a 

 

figure 3-4-6b 



3.5.7 Software information 

Select Help and then About VirtualDrive Network Console from the drop menu, 

the popup window will display the information about software license and version. 

3.5.8 Extracting files from VCD 

Users can access files from the VCDs without inserting them into the virtual drive. 

Click on a VCD icon in VirtualDriveTM tray, all its contents will be displayed in the 

bottom-right frame. Right click on the selected file and select Extract from the drop 
down menu. 

  

 

  

 

Specify a folder to save the extracted file. 



  

 

 

3.6 Viewing Client VCD Usage 

3.6.1 Viewing VCD Usage  

To view the usage of any particular VCD, click on the VCD name to select it then 

right-click and select Disc Usage History or click on File-> Disc Usage History to 

open the Statistic dialog. (shown below) 

 

    

Note 

Statistic function can take effect only after 

enables  ->View->Settings->Other->Verify the authority 
for VCD folder in VDN Console.  

  



 

  

Click on the Refresh button to Refresh the dialog and display the network usage 

statistics. 

3.6.2 Viewing User Statistics 

To view the statistics of any user, click on the name to select it then right-click and 

select Disc Usage History or click on File-> Disc Usage History to open the 

dialog (shown below). 



 

 

You may view the usage status in a period of time by appointing the date rage in the 

drop list. 

To back up the statistic result, click on Export and give a path to save the backup 

file. 

3.7 Backing up VCD List 

3.7.1 Backing Up VCD list 

Using this tool you can back up the information of the current VCD list in VirtualDrive 

and restore it at any time you like. 

Select File from VirtualDrive Manager menu, then Backup to save the VCD list in 

the hard disk. 



 

 

Enter a location to save the backup file (*.vdl). 

 

 
 



3.7.2 Restoring VCD List 

Select File from VirtualDrive Manager menu, select Restore. 

 

 

 

Select the VCD list you want to restore and select Open. 



 
 

3.8 Cloning CD/DVD or BD 

You can make an identical copy of an existing CD/DVD/BD onto another recordable 

disc. 

 In the Main Console, select Clone CD/DVD/Blu-ray. The way you clone your disc 

will depend on the number of CD/DVD/BD drives connected to your computer. 

  

Cloning a Disc with Two CD/DVD or BD Drives 

     Insert a blank disc into one CD/DVD/BD recorder, and then insert the source 

disc into your other CD/DVD/BD-ROM drive.  

 From the drop-down menu in the dialog box, select the drive containing the 

source disc. 

 Other options in this dialog box include: 

  



     Disc Information: View disc type, number of sectors, disc size, time, 
sessions, tracks, start sector, and end sector of the source disc. 

  

    Read Speed: Select a read speed from the dropdown menu. It is 
recommended to choose the Best Speed option. 

  

    Ignore read errors: Checking this box will set the burner to ignore read 
errors from the source disc. 

  

    On-the-fly: Checking this option enables quick cloning.  

  

 
Note 

If the on-the-fly option is checked, data will be taken directly from the source 

disc and burned on the target disc. 

  

If on-the-fly is not checked, data from the source disc will first be compressed 

as an Image and stored in a temporary files folder. The original contents of 
the source disc will then be burned to the target disc. 

  

This option is not available if there is only one CD/DVD or BD drive in your 
computer. 

  

Click Next to display a dialog box. Choose your burning settings and click Burn.  

  

Cloning a Disc when there is only One CD/DVD Drive 

 1.  Insert the source disc into your CD/DVD-ROM recorder.  

2. Select the source disc from the drop-down menu in the dialog box. 

3. Choose your burning settings and click Record in the dialog box. 

  

 
Note 

The next two steps are settings for making an Image. 

  



4. Select a CD/DVD read method. The default read method of "Intelligent Extraction" 

works with most CD formats. If you know what protection type is used on the 

CD, you may want to select the Other Protected CD type option.  

5. Using Data Compression will save hard disc space but will also require a longer 

build time. 

6. Enter a description for the Image in the description field. 

Optional: If the CD does not have an Auto-run file, you can specify for a program to 

run it when the Image is inserted into a virtual drive. 

7. Click Next. The image of the source disc will begin creating. When complete, the 

disc will automatically eject. 

8. Replace the source disc with a writable disc and click OK to continue. 

Chapter 4: Using the VDN Client Program 

4.1 Starting the VDN Client Program 

To launch VDN Client program, click on ->start->programs->VirtualDrive 

Network->VirtualDrive Network client. 

  

 



 

 

 

4.2 Running Virtual CD-ROMs (VCDs) 

There are several methods of inserting a VCD file. If the VCD has Autorun this will be 

run when the VCD is inserted. 

Click the Virtual Drive tab on the right-hand-side of the VDN window to display all 

Virtual Drives. 

Once in this view, there are several methods for Inserting a VCD. 

Method 1 Clicking on the VCD then the "Insert" button  will open a list of 
available drives. Select a drive to insert the VCD. 

Method 2 Double clicking on the VCD icon. will open a list of available VirtualDrives. 

Select a drive to load the VCD. 



(note: If only one VirtualDrive has been created, double-clicking on the VCD will 

automatically insert the VCD into this drive.) 

Note: See VDN Console VDrive.exe feature to create a custom Autorun VCD 

Method 3 Left click on the VCD and with the mouse button still de-pressed, drag the 

VCD icon onto a Virtual Drive icon. 

Method 4 Highlight a VCD icon and select "insert" from "edit" drop menu. 

Method 5 Select a VCD icon then press "insert" button on keyboard. 

Method 6 Right click on a VCD icon and select "insert" from the popup menu will 

open a list of available drives. Select a drive to insert the VCD. 

4.3 Ejecting a VCD  

Click the Virtual Drive tab on the right-hand-side of the VDN window to display all 

Virtual Drives. 

Once in this view, there are several methods to Eject a VCD. 

Method 1 Right click on the inserted VCD and select "Eject". 

Method 2 Click on the VCD then click on the "Eject"  button.   

Method 3 Click on the icon and with the mouse button still de-pressed drag the icon 

into the right-hand-side frame.  

Method 4 Click on the inserted VCD icon and press "Delete" key on the keyboard. 

Method 5 Highlight a inserted VCD icon and select "eject" from "edit" drop menu. 

Method 6 Right click on the VirtualDrive and select eject from the popup menu. 

4.4 Viewing VCD Properties 

To view the VCD properties, point to a VCD icon and right click to open the VCD 

properties window (shown below).  VCD properties cannot be edited from within the 
VDN Client program. 

 

 



 

  

 



 

 

 

4.5 Searching VCD 

Search VCD let users to search for VCDs being shared by the VDN Server.  Select 
File->Search or use hot key Ctrl+F to open Search VCD File window (figure below). 



 

 

Select VCD folder in Path drop menu or browse for folders by clicking on button. 

 

    

Note 

You can fill the Name field to narrow the search to VCDs with 

similar filename.  Use * as wildcard to match a search 
pattern. 

 

Select Search, the searched files will be displayed in the window. Right-click on the 

VCD file and select Insert to insert into a Virtual Drive. 

4.6 Setting the Number of Virtual Drives  

To change the Virtual Drives in your system (the maximum is 23), select "Number 

of VIirtual Drive " from the "View" menu to open the VirtualDrives dialog (Figure 

5-6a). Check the drive letter for each Virtual Drive that you want to Add/Remove, 

and then click OK to finish.  



 

                                           

    

Note 

Drive letter A, B, C, and D are normally reserved for 

Windows to use.  Check with your I.T. Console to see if any 

drive letter is reserved for future uses in your organization 
before allocating Virtual Drives.  

4.7 Updating changes from the VDN Server 

If you know that the Console has made changes to the CD Server, the VDN Client 

program can be updated to reflect these changes by either restarting the Client 

program or selecting View then Refresh on the Menu bar.  Or click on the Refresh 
icon. 



Chapter 5: Uninstalling VirtualDrive Network 

5.1 Uninstalling VirtualDrive Console  

Step 1 To uninstall VirtualDrive Network Console, select Start/Settings/Control 

Panel and double click on the Add/Remove Programs icon to open the 
Add/Remove Programs dialog, select VirtualDrive Network Add/Move button. 

Step 2 To confirm uninstall, click on OK. 

Step 3 Click on Finish to complete. 

Step 4 With the VirtualDrive Network program files removed, click on Yes to have 

the changes effect. 

The uninstall program will purge all files created by VirtualDrive Network except files 

ending with the extension VCD. Your Virtual CD-ROM files can be deleted using the 

Windows Explorer. If you keep these files, they can be manually added to the VDN 

Server if you reinstall the VDN Console. 

5.2 Uninstalling VirtualDrive Client 

Step 1 To uninstall VirtualDrive Network Console, select Start/Settings/Control 

Panel and double click on the Add/Remove Programs icon to open the 
Add/Remove Programs dialog, select VirtualDrive Network Add/Move button. 

Step 2 To confirm uninstall, click on OK. 

Step 3 Click on Finish to complete. 

Step 4 With the VirtualDrive Network program files removed, click on Yes to have 

the changes effect. 

The uninstall program will purge all files created by VirtualDrive Network except files 

ending with the extension VCD. Your Virtual CD-ROM files can be deleted using the 

Windows Explorer. If you keep these files, they can be manually added to the VDN 

Server if you reinstall the VDN Console. 



5.3 Uninstalling VirtualDrive Network Server 

Step 1 To uninstall VirtualDrive Network Server, select Start/Settings/Control 

Panel and double click on the Add/Remove Programs icon to open the 

Add/Remove Programs dialog, select VirtualDrive Network Server then click on the 
Add/Remove button. 

Step 2 To confirm uninstall, click on OK. 

Step 3 Click on Finish complete uninstall. 

Chapter 6: Appendix 

6.1 FAQ 

Q1: Why cannot I fail to install VDN Console or VDN Client, or these two 

components cannot work properly?  

Please check the following three points and retry: 

1. Make sure VDN Server has been installed successfully. 

2. If you haven't share a file or folder before, make sure run the "Network Setup 

Wizard" or "Just enable file sharing".  
3. Make sure the computer of VDN Server has started up. 

 

Q2: Why the time for building protected CD is much longer than building 

other sorts of CDs? 

You must build protected CDs with intelligent extraction, otherwise the building is 

hard to finish because it cost overmuch time or the VCD is unreadable after the 

building. Another reason for this phenomenon is that at the beginning of the building, 

VirtualDrive slows down the speed while reading data from some protected area on 

the CD (as laserlock, safedisk, securom), so the time estimate to finish will be 

prolonged. The VirtualDrive will speed up once finish the building on this area and 
the time remains will be reduced as well. 

  

Q3: Does the building time vary depending on the quality of the real 
CD-ROM drive? 



The reading speed of CD-ROM drives produced by different manufacturer diverse 

varies a lot due to their error-correction ability and other mechanisms. Therefore, 

the building speed mostly depends on the quality of CD-ROM drive instead of 
VirtualDrive program. 

  

Q4: Can I convert a VCD file, which is built by intelligent extraction,  into a 

ISO file? 

The standard of the VCD file that built by using Intelligent Extraction is different from 

ISO file. So it cant be converted into a ISO  file.   

  

Q5:  Does VirtualDrive support IEEE1394 or USB CD-ROM? 

VirtualDrive 7.03 or later version support IEEE1394 or USB CD-ROM. If you still 

possess the old version, you can download the newer one from our website. 

  

Q6: VirtualDrive auto-plays the contents of virtual CD at system start-up. 

How can I stop the auto-play? 

Uncheck Enable CD autorun box from View-> Settings -> Miscellaneous 

settings in VirtualDrive menu bar. 

 

Q7: Why does the game application still ask me to insert the CD when the 

virtual CD is already inserted?   

You may resolve this problem by trying either of the following methods: 

a. Change a CD drive's drive letter by using  "Disk Management" in Windows: 

right-click My Computer->Manage->Disk Management, right click the interested 
drive, select "Change Drive Letter and Paths" to change drive letter. 

b. Build this game CD by using intelligent extraction. 

  

Q8: Why does the system always prompt that "Please insert a disk into 

drive" after I insert a VCD (built from Mixed-Mode CD) into a virtual drive? 

The problem may be caused by the file Filter Driver in the application Ahead Nero 

5.5.6.4. The Filter drive is not compatible with VirtualDrive, it makes VirtualDrive 

unable to read data on VCDs with sound tracks. You can resolve the problem by 
uninstalling Nero from the Computer. 

  

Q9: Why the maximum number of virtual drive is 23? 



There are 26 letters in alphabet. We suppose that A: and B: are floppy drives on 

your computer, C: is the entire hard disk, and therefore there are 23 letters left 

(D-Z), each one can be assigned to a drive. So you can create at most 23 virtual 
drives. 

  

Q10: Does VirtualDrive support protected game CD? 

The answer is yes, VirtualDrive supports various protected game CDs as: 

Mixed-Mode protected, Safedisk1, Safedisk2, Securom, Laserlock, etc. 

  

Q11: Why can't I hear the background music while playing game? 

The background music of some mixed-mode CD is available only if the CD is inserted 

in the first CD-ROM on the system. 

  

Q12: Some games require more than one CD for playing. How can I replace 

CD without interrupting the game? 

VirtualDrive enables users to use hot-key to insert a CD. Preset a hot-key and virtual 

drive for the CDs and you can insert them into the designated drive by using the 

hot-key without stopping the game. 

  

Q13: What sort of CD need to be built by using "Intelligent Extraction"? 

Some protected CDs as Securom should use intelligent extraction to build. 

  

Q14: After I set the number and position of virtual drives on 

WindowsXP/2003 Server, VirtualDrive regards virtual drive as real CD-ROM 

drive. How can I correct this? 

There are two ways to resolve this problem: (1) Restart your computer (2) Refresh 

in Device Manager 

  

Q15: The drive letter of real CD-ROM was arranged to the tail. How can I 

change the drive letter sequence? ( e.g. change F: to E:) 

You can assign a drive letter to a CD-ROM drive by the following steps: 

Windows 2000/XP/2003 Server only 

(1) Right click on "my computer" from desktop, select manage --> disk 

management . 



(2) Make sure which one is virtual drive. 

(3) Right click on virtual drive icon, select "change drive letter or paths" from the 

drop menu. 

  

Q16: Can two or more Console exist in a local area network? 

No, only one Console is allowed to exist in a local area network. 

  

Q17: I do not want somebody to see the shared VDN directory via My 

Network Places, how can I hide it? 

You can keep the directory invisible on a network by renaming the folder name as 

VDN$. 

Software License Agreement 

FARSTONE TECHNOLOGY, INC. (FARSTONE) END USER LICENSE AGREEMENT FOR 

VirtualDrive Network, HEREAFTER REFERRED TO AS THE "SOFTWARE"  

PLEASE READ CAREFULLY: THE USE OF THIS "SOFTWARE" IS SUBJECT TO THE 

"SOFTWARE" LICENSE TERMS OF FARSTONE AND OTHER LICENSORS WHOSE 

SOFTWARE MAY BE BUNDLED WITH THIS PRODUCT.  

BY YOUR USE OF THE "SOFTWARE" INCLUDED WITH THIS PRODUCT YOU AGREE TO 

THE LICENSE TERMS REQUIRED BY THE LICENSOR OF THE "SOFTWARE", AS SET 

FORTH BELOW.  IF YOU DO NOT AGREE TO THE LICENSE TERMS APPLICABLE TO 

THE "SOFTWARE", YOU MAY RETURN THE ENTIRE UNUSED PRODUCT FOR A FULL 
REFUND.  

LICENSE AND WARRANTY:  

The software which accompanies this license (the "Software") is the property of 

FARSTONE or its licensors and is protected by copyright law. While FARSTONE 

continues to own the Software, you will have certain rights to use the Software after 

your acceptance of this license. Except as may be modified by a license addendum 

which accompanies this license, your rights and obligations with respect to the use of 

this Software are as follows:  

A. Single User License:  

(a) use the "Software" on a single computer system or network, and only by a single 

user at a time. If you wish to use the "Software" for more users, you will need an 
additional License for each user.  



(b) make one copy of the "Software" in machine-readable form solely for back-up 

purposes, provided you reproduce FarStones copyright proprietary legends. 

Notwithstanding the foregoing, the "Software" may be used on the home, laptop or 

other secondary computer of the principal user of the "Software", and an additional 

copy of the "Software" may be made to support such use. As used in this License, 

the "Software" is "in use" when it is either loaded into RAM or installed on a hard 

disk or other permanent memory device. The "Software" may be "in use" on only 

one computer at any given time.  (Different License terms and fees are applicable 

for networked or multiple user applications.)  As a specific condition of this License, 

you agree to use the "Software" in compliance with all applicable laws, including 

copyright laws, and that you will not copy, transmit, perform or distribute any audio 

or other content using the "Software" without obtaining all necessary Licenses or 
permissions from the owner of the content.  

B. Multiple User License:  

Make one copy of the "Software" in machine-readable form solely for back-up 
purposes, provided you reproduce FarStones copyright proprietary legends.  

You must acquire and dedicate a License for each separate computer on which any 

part or portion of the "Software" is installed or run As used in this License, the 

"Software" or any part or portion of the "Software" is "in use" when it is either 

loaded into RAM or installed on a hard disk or other permanent memory device 

including any networked or shared environment where either direct or indirect 

connections are made through software or hardware which pools or aggregates 

connections.  

As a specific condition of this License, you agree to use the "Software" in compliance 

with all applicable laws, including copyright laws, and that you will not copy, transmit, 

perform or distribute any audio or other content using the "Software" without 
obtaining all necessary Licenses or permissions from the owner of the content.  

C. Restrictions: You may not distribute copies of the "Software" to others or 

electronically transfer the "Software" from one computer to another over a network.  

You may not post or otherwise make available the "Software", or any portion thereof, 

in any form, on the Internet.  You may not use the "Software" in a computer service 

business, including in time-sharing applications. The "Software" contains trade 

secrets and, in order to protect them, you may not decompile, reverse engineer, 

disassemble, or otherwise reduce the "Software" to a human-perceivable form. YOU 

MAY NOT MODIFY, ADAPT, TRANSLATE, RENT, LEASE, LOAN, RESELL FOR PROFIT, 

DISTRIBUTE, NETWORK OR CREATE DERIVATIVE WORKS BASED UPON THE 

"SOFTWARE" OR ANY PART THEREOF.  

D. Limited Warranty:  

Farstone warrants that the media on which the Software is distributed will be free 

from defects for a period of thirty(30) days from the date of delivery of the Software 

to you. Your sole remedy in the event of a breach of this warranty will be that 

Farstone will, at its option, replace any defective media returned to Farstone within 

the warranty period or refund the money you paid for the Software. Farstone does 

not warrant that the Software will meet your requirements or that operation of the 
Software will be uninterrupted or that the Software will be error-free.  

THE ABOVE WARRANTY IS EXCLUSIVE AND IN LIEU OF ALL OTHER WARRANTIES, 



WHETHER EXPRESS OR IMPLIED, INCLUDING THE IMPLIED WARRANTIES OF 

MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. 

THIS WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS. YOU MAY HAVE OTHER 
RIGHTS, WHICH VARY FROM STATE TO STATE.  

E. Limitation of Liability: IN NO EVENT WILL FARSTONE OR ITS LICENSORS BE 

LIABLE TO YOU FOR ANY INCIDENTAL, CONSEQUENTIAL OR INDIRECT DAMAGES, 

INCLUDING ANY LOST PROFITS, LOST SAVINGS, OR LOSS OF DATA, EVEN IF 

FARSTONE OR A LICENSOR HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH 

DAMAGES, OR FOR ANY CLAIM BY ANY OTHER PARTY.  Some states do not allow the 

exclusion or limitation of special, incidental, or consequential damages, so the above 
limitation or exclusion may not apply to you.  

  

F. General: You acknowledge that you have read this Agreement, understand it, and 

that by using the "Software" you agree to be bound by its terms and conditions. You 

further agree that it is the complete and exclusive statement of the agreement 

between FarStone and you, and supersedes any proposal or prior agreement, oral or 

written, and any other communication between FarStone and you relating to the 

subject matter of this Agreement.  No additional or any different terms will be 

enforceable against FarStone unless FarStone gives its express consent, including an 

express waiver of the terms of this Agreement, in writing signed by an officer of 

FarStone. You assume full responsibility for the use of the "Software" and agree to 
use the "Software" legally and responsibly.  

Should any provision of this Agreement be declared unenforceable in any jurisdiction, 

then such provision shall be deemed severable from this Agreement and shall not 

affect the remainder hereof. FarStone reserves all rights in the “Software” not 

specifically granted in this Agreement.  

Should you have any questions concerning this Agreement, you may contact 

FarStone by writing to:  

FarStone Technology, Inc.  

1758-B North Shoreline Blvd 

Mountain View, CA 94043 
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